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--

File: "readme700.txt"
Date: October 04, 2002
Software: MET/CAL V7.00

Welcome to MET/CAL V7.00.

------------------------------------------------------------------------------
--

This document is divided into 7 sections:

1. What's New in V7.00

Description of significant new features in V7.00.

2. MET/CAL

Changes which affect one or more MET/CAL applications are
listed here.

Since MET/TRACK V7.00 is a new application, rather than an
upgrade of the V6 Manual Entry and DB Setup applications,
detailed MET/TRACK changes are, in general, not listed in
this section. Consult the MET/CAL V7.00 Users Manual for
a description of MET/TRACK V7.00.

3. Documentation.

Overview of product documentation.

4. Manuals Errata

Errors found in the MET/CAL V7.00 manuals. These errors
were uncovered after the manuals "went to press".

5. Reports

Reports provided with MET/CAL V7.00.

6. On Time Support Products

On Time Support products which work
with the MET/CAL database.

7. Contacting Fluke

How to contact Fluke with MET/CAL questions, problems,
or suggestions.

------------------------------------------------------------------------------
--

Section 1 What's New in V7.00

This section describes significant changes between MET/CAL V6.11A
and MET/CAL V7.00.

1. New MET/TRACK

The MET/TRACK application has been rewritten for the V7.00
release.

There's now a single application ("mettrack.exe") rather
than two separate applications (Manual Entry and DB Setup).
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Login as "MT" to obtain administrator functionality (as in
V6 DB Setup).

The MET/TRACK user interface is substantially different in
V7.00, but all significant V6.00 functions have been
preserved.
Please consult the MET/CAL V7.00 Users Manual for a
description
of the features and operation of MET/TRACK V7.00.

2. Fluke 8508A

MET/CAL V7.00 supports the new Fluke 8508A Reference
Multimeter. Refer to the documentation for the "8508" and
"M8508" FSCs for details. Documentation is available within
the MET/CAL Editor (F1) or in the MET/CAL V7.00 Reference
Manual ("ReferenceManualV7.pdf").

3. Agilent E4418B and E4419B Power Meters

MET/CAL V7.00 supports the Agilent E4418B and E4419B power
meters. Refer to the documentation for the "4418", "M4418",
"4419", and "M4419" FSCs for details. Documentation is
available within the MET/CAL Editor (F1) or in the MET/CAL
V7.00 Reference Manual ("ReferenceManualV7.pdf").

4. Agilent 33250A Function Generator

MET/CAL V7.00 supports the Agilent 33250A function generator.
Refer to the documentation for the "33250" and "M33250"
FSCs for details. Documentation is available within the
MET/CAL Editor (F1) or in the MET/CAL V7.00 Reference Manual
("ReferenceManualV7.pdf").

5. Change Procedure Directory

MET/CAL (Run Time and Editor) now allow the default procedure
directory to be changed.

6. Measurement Uncertainty Improvements

MET/CAL V7.00 supports the Welch-Satterthwaite calculation.
The procedure writer may now specify sensitivity coefficients
and degrees of freedom for each uncertainty component.
The coverage factor used to determine the expanded uncertainty
is dynamically calculated from the combined degrees of freedom
(Welch-Satterthwaite), the T-distribution, and a specified
confidence value. All new features are optional.

7. Picture File Formats

MET/CAL V7.00 supports JPEG, GIF, EMF, WMF, and ICO in
addition to BMP.

8. Results Table

MET/CAL V7.00 writes calibration results data to a new
database table, called the Results Table.

The V6.00 Calresults Table remains part of V7.00. By default
the V7.00 Run Time application writes results data to both
the Results Table and the Calresults Table.

Reports which work with V6 will continue to work with V7,
after they are verified against the new database.

MET/CAL V7.00 includes a number of new reports which work
with the V7 Results Table.
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The fundamental difference between the Calresults Table and
the Results Table is that in the Results Table each individual
result quantity is stored in one or more separate columns.

The format file "rslt_db.frm" has no effect on the Results
Table or on reports which report data from the Results Table.

See the on-line reference "ResultsTable7.pdf" for a detailed
list of MET/CAL V7.00 result quantities.

9. New Version of Sybase SQL Database.

MET/CAL V7.00 uses Sybase V8.

10. New Version of Crystal Reports

MET/CAL V7.00 uses Crystal Reports V8.

------------------------------------------------------------------------------
--

Section 2 MET/CAL

----> New Picture File Formats

Reports #2049, #7269, #9018, #11510

In MET/CAL V7.00 picture display is handled via an ActiveX DLL
("mcpic.dll") which uses the Visual Basic "Image Control".
This control supports the following picture file formats:

.bmp - Bitmap

.jpg - JPEG

.gif - Graphics Interchange Format

.emf - Enhanced Metafile

.wmf - Windows Metafile

.ico - Icon

Prior to V7.00 only the ".bmp" format was supported.

Pictures may be resized by the user. The maximum picture
size is full screen. The minimum picture size is constrained
by the buttons ("Advance" and "Terminate" for PIC, "Yes",
"No", and "Terminate" for PICE).

----> Add Yes/No/All/Quit Confirmation Prompt to Procedure Deletion

Report #5025

Users have stated they would like to see some sort of
Yes/No/All/Quit prompt to confirm that procedures really
should be deleted before doing the actual deletion.

"Delete Procedures" is now part of the Editor's "File"
menu. It includes a "Search" button as well as an optional
confirmation dialog. Users may remove "Delete Procedures"
from the "Tools" menu. The "MET/CAL Administrator"
application
is no longer needed.

----> Control of Font Used by PIC and PICE for Text Overlays

Report #5531

In V6.11g and later the Editor and Run Time support a
configurable Picture Font used for text overlays by the PIC
and PICE FSC. This allows the font (facename), style
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(regular,
italic, bold, or bold italic), and pointsize to be controlled.

----> Add an Option to Select Multiple Procedure Directories

Report #7711

Customers have requested that more than one procedure
directory
should be accessible from the Run Time and Editor
applications.

The MET/CAL Editor and Run Time have been changed to support
multiple directories.

A new "Change Default Directory" (Ctrl+D) menu item has been
added to the top-level "File" menu of the Editor.

Choosing "Change Default Directory" causes a
"Choose Default Procedure Directory" dialog to appear.
The standard Windows common dialog for browsing and choosing
a file is used.

If the user chooses a directory which does not contain a
MET/CAL procedure directory file ("proc.dir"), an empty
"proc.dir" is created in the directory.

Using "Change Default Directory" causes the "procdir"
parameter in the MET/CAL initialization file ("metcal.ini")
to be updated.

Changing the default directory in the Editor affects the Run
Time as well, and vice versa.

When executing a procedure in Run Time or Test Run, all
required subprocedures must be present in the currently
selected default procedure directory.

A number of related changed have been made to the Editor
as well:

(1) "Save As" in the "File" menu now refers to a submenu
containing two menu items:

"Save As Compiled Procedure..."
"Save As Text Procedure..."

The first submenu items causes a browse dialog to be
displayed, allowing the user to choose the procedure
directory where the procedure is to be saved. This does
not change the default procedure directory.

"Save As Text Procedure..." functions identically to the
"Save As..." menu item in the "File" menu in V6 and
prior.

(2) "Save Procedure" in the "File" menu (Ctrl+S) functions as
it always has. However, if the default procedure
directory has been changed since the time the procedure
to be saved was loaded or last saved, "Save Procedure"
saves it to the original procedure directory (i.e.,
to the procedure from which it was loaded or to which
it was most recently saved).

(3) There's a second new menu item in the "File" menu:
"Save to Default Directory". This menu item causes the
procedure to be saved to the current default procedure
directory, regardless of where it was loaded from or
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was last saved to.

(4) If the user attempts to close the Editor or close a child
window in a situation where procedure changes haven't been
saved yet, the "How Should the File be Saved?" prompt
dialog now includes "Save As Proc" and "Save As Text"
buttons instead of the "Save As" button in V6 and prior.
"Save As Proc" allows the user to browse for a procedure
directory to save the file in compiled form.
"Save As Text" functions like the "Save As" button in
this dialog in V6 and prior.

(5) The usual "Create New or Overwrite" dialog appears
whenever

a compiled procedure is being saved to the procedure
directory from which it was loaded or, if it has already
been saved at least once, whenever it is being saved to
the directory where it was most recently saved.

The "Create New or Overwrite" dialog does not appear
if the procedure file was loaded from a text file,
or entered from scratch, or if it is being saved to a
directory different from the one from which it was loaded
or most recently saved. In this case, if there is a name
conflict with a procedure already in the directory, an
error message is generated and the user is presented with
the option of either overwriting the procedure with which
there is a name conflict or canceling the save operation.

It is important to realize that the change described above
does not provide a "tree-structured" procedure directory.
Rather, it simply makes it more convenient to change the
default procedure directory.

----> MATH Functions to Read Accuracy Data

Report #8640

V7.00 includes two new MATH FSC functions used to read
accuracy file data. The functions are ACCV and ACCV2.

The functions may be used with Fluke-provided accuracy files
for MET/CAL-supported system instruments, like the Fluke
5700A, or may be used with user-configured instruments for
which the end user provides the required accuracy file.

Refer to the on-line help for the MATH FSC for a full
description of ACCV and ACCV2.

----> Support Agilent/HP E4418A (EPM-441A) Single Channel Power Meter

Report #8919

MET/CAL V7.00 supports the Agilent 4418A power meter.

The new FSCs are 4418 and M4418.

----> Scientific Notation in Error Column of Results

Report #8993

A user who does a lot of mechanical calibration states that
he does not like the scientific notation in the error column
and would like to be able to turn it off in the results file
and get actual error in decimal format. It is confusing
for his customers in the format 3e-2.

The V7.00 implementation is such that in most cases the Error
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is not formatted using scientific notation. This statement
applies to the V7.00 Results Table, not to "legacy results".

In V7.00 the Error is formatted per the UUT Resolution.
For typical UUT Resolution values this approach does not
use E-format (scientific notation).

----> Add Capability to Distinguish Accredited / Non-Accredited
Measurements

Report #9859

A customer who has an accredited lab and uses MET/CAL wants
to have an additional "*" on the report on the measurements
where he has no accreditation.

Here's additional information provided by a Fluke
representative:

The DKD, and also NAMAS, as I learned from Wavetek
reports, allows the inclusion of a certain number
of non-accredited test steps in cal reports. They
must be marked, e.g., with an asterisk ('*'), to
identify the relevant tests, and a comment in the
report has to explain this feature.

To be able to mark tests the MET/CAL Editor must
provide a way to include the information about
accreditation with each test, and there must be a
mechanism for transferring this information to the
cal report. Maybe such a flag could be set with a
VSET statement.

The DKD is beginning to require that non-accredited
tests be shown on cal reports with a gray background.
Crystal Reports could make use of this new flag to
do so.

The DKD allows 10 to 15 % of the DKD certificate to
be non-accreditated tests, but of course not for
all the main functions of the UUT. Examples for
non-accreditated tests could be the lowest voltage
and current ranges, certain frequencies etc.

If there are non-accreditated tests in a report,
it must be explained with a comment line at the
bottom of every page.

MET/CAL V7.00 supports an Accreditation Flag. The parameter
name, using the VSET FSC, is "ACCRED". A procedure may
enable or disable the Accreditation Flag on a per-test basis.
See "vset.hlp" for additional information.

----> Change the ACC FSC to Use Units Prefixes

Report #10236

An option is needed that would force the compiler to look
for a recognized units prefix at the beginning of the
"string" portion of the ACC Nominal field. For example,
in the following TUR report generated using 6.11A, the
system accuracy is not the same for test 1 and test 2.
Basically, test 2 assumes the nominal field is base units
because the "uA" is just an arbitrary string. However the
5700 evaluation converts the Nominal value to amps before
computing the system accuracy.

Calibration Training MET/CAL Procedure
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===========================================================
INSTRUMENT: Test Case: ACC Prefix
DATE: 2002-09-05
AUTHOR: Fluke
REVISION: 1.0
ADJUSTMENT THRESHOLD: 70%
NUMBER OF TESTS: 2
NUMBER OF LINES: 19
CONFIGURATION: Fluke 5700A
===========================================================
# Use 5700A 1 year, 99% accuracy file.
1.001 ACCF 5700 5700_99.1yr
1.002 5700 100.0uA 1.0U 2W
#! Test Tol 1e-006, Sys Tol 1.6e-008, TUR 62.5000 (>= 4.00).
# 5700A 1 year, 99% accuracy at 100uA is 60ppm + 10nA.
2.001 ACC 100.0uA 60P% 0.01U
2.002 MEMI Enter the UUT reading in microamps:
2.003 MEMCX 100.0uA 1.0U
#! Test Tol 1, Sys Tol 0.016, TUR 62.5000 (>= 4.00).

In V7.00 MET/CAL parses and converts units prefixes as
it does for an instrument FSC. This does not affect the
T.U.R. (the ratio), but it does change the system accuracy,
which affects the measurement uncertainty calculation.

ACC now operates in a manner consistent with an instrument
FSC setup statement (MOD4 = "S").

----> Add Sensitivity Factors to Measurement Uncertainty Calculation

Report #11992

Sensitivity coefficients have been implemented in MET/CAL
V7.00
as optional VSET parameters. The parameter names are
C1, C2, ..., C10. Refer to the VSET on-line documentation
for details.

----> Add Search Function in "Copy Procedures"

Report #13687

The MET/CAL Editor's "Copy Procedures" function, currently
accessed via the "Tools" menu, should be enhanced to include a
"Search" function.

In V7.00 "Copy Procedures" is now part of the Editor's "File"
menu. The "Copy Procedures" dialog includes a "Search"
button.

----> Support Agilent/HP E4419A (EPM-442A) Dual Channel Power Meter

Report #14552

MET/CAL V7.00 supports the Agilent 4419A dual channel
power meter.

The new FSCs are 4419 and M4419.

----> Control of "Please Remove All Connections..." Message

Report #14599

In V7.00 there's a new "REMCON" parameter which may
be specified in a VSET statement or in the MET/CAL
initialization file. "REMCON = no" turns off the "Please
Remove All Connections..." message. The default value is
"yes". A VSET specification overrides an initialization
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file specification, if any.

Users running MET/CAL workstations dedicated to mechanical cal
may wish to specify "remcon = no" in "metcal.ini". This turns
off the message for all procedures, unless specifically
turned back on in a procedure using "VSET REMCON = yes".
For other types of MET/CAL workstations (electrical workload),
it will probably be more appropriate to specify "remcon =
yes" in "metcal.ini" (or equivalently, not specify "remcon"
in "metcal.ini"), and then specifically disable the message
using "VSET remcon = no" in specific procedures where the
message is unneeded.

----> 3325 & M3325 FSCs Omitted from PDF Reference Manual

Report #14628

The "3325" & "M3325" FSCs were inadvertently omitted from the
V6.11 PDF reference manual.

Customers will have to rely on the MET/CAL Editor's on-line
help files for these two FSCs until a reference manual update
is available.

The V7.00 Reference Manual includes sections for the 3325
and M3325 FSCs.

----> MATH Functions to Access Measurement Uncertainty Data

Report #14633

V7.00 includes two new MATH FSC functions used to access
measurement uncertainty data from the most recent evaluation.
The functions are "UNC" and "UNCV".

"UNC" takes as an argument a string which designates the
desired measurement uncertainty parameter. For example,
to access the standard deviation of the measurements a
statement like:

MATH MEM = UNC("SDEV")

may be used.

"UNCV" provides access to the individual measurements.
The argument is the index of the desired measurement. A valid
index is a value between 1 and NMEAS, where NMEAS is the
number of measurements for the evaluation step just completed.

Refer to the on-line help for the MATH FSC for details.

----> Config Editor Lists Pressure Modules Separately

Report #14698

In V7.00 there's a minor enhancement to the MET/CAL Config
Editor (invoked via F12 in Run Time and Editor) to display the
pressure modules separately from the main "Add Instrument"
dialog. Choose either "Fluke 525A Pressure Module..." or
"Fluke 700 Pressure Module..." in the "Add Instrument" dialog,
then choose OK to display a secondary dialog which allows a
specific pressure module to be selected. In addition, the
"Add
Instrument" dialog has been enlarged to show more instruments.

----> Cannot Run "Quick Sort" on Win2000

Report #14691
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In V6.11A running "Quick Sort" on a Win2K platform
results in an error message stating that an incorrect
version of COMCTL32.OCX is present.

The MET/CAL V7.00 Install Program correct this problem.

----> List Pressure Modules in Separate List Box for Config Editor
"Add" Option

Report #14698

There are so many pressure modules that the instrument
configuration editor currently lists them at the end of the
"Add Instrument" list box. This was done so a user would
not have to scroll past all the pressure modules in order
to get to instruments like the Wavetek 395. However now
you have to scroll to the bottom of the list box and then
search backward for a desired pressure module. A cleaner
approach would be to have a single entry in the Add Instrument
list box such as "Fluke 700 Pressure Module...", which when
selected would display a separate list box with only the 700
series pressure modules.

V7.00 implements the change described above.

----> 33120 DC Offset Limits Incorrectly Calculated when Amplitude
Taken from Memory Register MEM

Report #14711

For example, in V6.11A and prior, the following procedure
statements:

1.001 MATH MEM = 2
1.002 M33120 -4Voff
1.003 33120 Vpp 1kH SI S
L

casue the following run time error:

E7412: FSC 33120: DC offset out of range. Limits are
+/-(0 to 0) for 0Vpp.

The underlying problem is that the limits check fails to
use the value in register MEM as the 33120 NOMINAL value.

A work-around is to directly specify the Nominal value in
the 33120 statement. For example:

1.003 33120 2Vpp 1kH SI S
L

V7.00 corrects this problem.

----> MATH Functions to Convert between Decibels and Volts (RMS)

Report #14716

In V7.00 the MATH FSC includes functions "DBTOV" and "VTODB"
to convert between RMS voltage and decibels. The reference
impedance must be specified.

----> TARGET FSC Omitted from PDF Reference Manual

Report #14732

In V6.11A the TARGET FSC help file is not included in the
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PDF version of the Reference Manual.

Users of V6.11A and earlier must rely on the Editor's on-line
help to access the TARGET FSC reference information.

The V7.00 reference manual ("ReferenceManualV7.pdf") includes
the TARGET FSC.

----> Keithley 2000 AC Measurements Cause Run Time Error

Report #14757

In MET/CAL V6.11 and V6.11A execution of a "2000" FSC
to perform an AC measurement causes a run time error.
The Keithley 2000 generates an error code of -113 ("improper
header").

This problem is not present in V6.10.

V6.11c or later is required to correct this problem.

----> MATH FSC Parsing Error when Function Argument is Literal
Negative Number

Report #14762

In V6.11A and prior there's an error in the MATH FSC
expression parser which prevents the recognition of the
second or subsequent function argument when that argument
is a literal negative number.

For example,

MATH MEM = MAX2(-26, -27)

generates a compile time syntax error.

The work-around is to enclose the literal number in
parentheses:

MATH MEM = MAX2(-26, (-27))

Another work-around is to place the argument value in
a register:

MATH M[100] = -27
MATH MEM = MAX2(-26, M[100])

This problem affects all functions which have a numeric
argument other than in the first position.

The problem has been corrected in V6.11c or later.

----> RSS Function Added to MATH FSC

Report #14763

V7.00 includes a new "RSS" function in the MATH FSC. "RSS"
performs a root-sum-square calculation on a sequence of
numbers in a specified range of numeric registers.

Unlike the existing "RSS2" and "RSS3" functions, "RSS" handles
up to 255 values, as long as the numeric "M" registers are
pre-loaded with the necessary values.

Refer to the on-line help for the MATH FSC for a full
description.
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----> MATH FSC Function to Return Confidence from Accuracy File Header

Report #14764

In MET/CAL V7.00, a new MATH FSC function, "CONF", may be
used to read the confidence value from the header of an
accuracy file associated with a specified reference.

See the on-line help for the MATH FSC for details.
Requires V6.11f or later.

----> MET/TEMP: Accuray Data Incorrect for Hydra 2620 and 2625

Report #14769

In MET/TEMP V6.11, accuracy information for the Hydra 2620
and 2625 in the accuracy file "hydacc._sd" is incorrect.

Data before and after the correction are shown below:

Before:

RTD2620=-200:0.06~0:0.09~100:0.11~300:0.14~600:0.20

After:
RTD2620=-200:0.13~0:0.09~100:0.12~300:0.24~600:0.56

----> 9500 DCV Statements May Fail in Demo Mode

Report #14797

In V6.11A, the following statement may cause an unhandled
exception error when executed in demo mode:

9500 0V S

V6.11e or later is required to correct the problem.

----> Running 1271-Based Procedure with Configured 1281 Fails in
Some Cases

Report #14814

In V6.11A and prior 1271-based procedures which use
information
specified in the auxiliary FSC, M1271, do not function
correctly when the procedure is used with a configured 1281.
The M1271 FSC serves 3 purposes:

(1) Specification of range locking.
(2) Enabling the filter for DC voltage, DC current,

& resistance measurements.
(3) Specifying the guard connection.

Running a 1271-based procedure with a configured 1281 will
therefore result in a procedure which executes without range
locking, with the filter disabled, and with no remote guard
connection.

Possible work-arounds for the problem are:

(a) Re-write the procedure to be 1281-based.

(b) Configure the instrument as a 1271 (even though
it's really a 1281). (Note: The asset in the
database will still be recorded as a 1281, so
the list of standards used will remain correct
when a cal report is generated for a UUT where
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the 1281 was used as a reference.)

V6.11g or later is required to correct this problem.

----> Support Datron-Yokogawa 9100

Report #14828

A customer in Japan would like to use MET/CAL V6.11A with the
Datron-Yokogawa 9100. The manufacturer portion of the
response
to IDN? for the Yokogawa-branded 9100s is "Datron-Yokogawa".
MET/CAL V6.11A accepts only "Wavetek Ltd" and "Fluke".

MET/CAL V7.00 has been updated to accept the Yokogawa-branded
versions of the 9100. Contact Fluke Japan or MET/SUPPORT
for details.

-----> ACC, MEMC, & MEMCX Base Units Presumption Causes Uncertainty
Confusion

Report #14840

In V6.11A and prior the MEMC, MEMCX, and ACC FSCs do not
parse the units portion of the NOMINAL field in the same
way that an instrument FSC does. In particular, the units
prefix, if any, is not recognized. This means that MET/CAL
never scales values entered with these FSCs, even if a units
prefix is, or appears to be, present.

This design dates back to MET/CAL V1.0 (and earlier -- 7411B
running on a Fluke 1720 instrument controller). The original
intent was probably to allow non-supported units to be used,
and this was accomplished by allowing arbitrary strings to be
entered in the non-numeric portion of the MEMC NOMINAL field.

Prior to the introduction of the measurement uncertainty
calculation in MET/CAL this design (i.e., not parsing the
MEMC/MEMCX/ACC NOMINAL units), although it was inconsistent
with instrument FSCs, did not cause significant problems,
since the entered string was used to annotate the results,
and the procedure writer was able to ensure that the two
quantities being compared (measurement and expected value)
were
in commensurate units (e.g., both in mV, or both in V, etc.).

The introduction of measurement uncertainty, however,
complicated things. MET/CAL, by design, expects to do the
measurement uncertainty calculation entirely in base units.
A procedure which includes ACC+MEMC or ACC+MEMCX tests, and
which calculates measurement uncertainty, is now forced to
use base units in the procedure. This prevents the procedure
from being written to conform directly to UUT capabilities.

If a user writes an old-style ACC+MEMC test and uses a
units prefix, MET/CAL will (in fact) perform the measurement
uncertainty calculation in scaled units, but will generate
the standard and expanded uncertainties (result quantities)
as if they were in base units. (The problem is that the
software is unaware of the units prefix, and is simply doing
the uncertainty calculation using the numbers as entered.)

In V7.00 MET/CAL parses and interprets units prefixes in MEMC,
MEMCX, and ACC statements. This affects the measurement
uncertainty calculation when scale units are used.

The measurement uncertainty module has been changed so
that the UUT Resolution, as determined by the V7.00 result
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generating and formatting code, is used directly in the
uncertainty calculation.

The algorithm by which the UUT Resolution is inferred now
is based on parsing the units prefix in ACC, MEMC, and
MEMCX statements.

Similarly, when the raw measurements (on which the standard
deviation is based) are scaled to base units, the units prefix
for a MEMC or MEMCX evaluation, is now taken directly from
the evaluation FSC NOMINAL field.

For example, if the procedure writer specifies:

MEMC 1.00mV 0.1%

the 'm' in "1.00mV" now matters. The readings will be taken
to be mV values.

----> Datron 4808 Transition from 100 V, 100 kHz to 1900 mA, 1 kHz
Causes Settings Conflict Error

Report #14876

The 4808 driver in MET/CAL V6.11A produces a settings conflict
error when a transition from AC voltage to AC current is
attempted and the AC voltage frequency is not valid in AC
current mode.

The problem also occurs with the 4200, 4200A, 4700, 4705,
4707, 4708, 4800, 4800A, and 4805 FSCs.

V6.11i or later is required to correct this problem.

----> Datron 4808 Driver in Resistance Mode Causes Two-Wire to
Four-Wire Transition Even When Already in Four-Wire Mode

Report #14877

In V6.11A the 4808 driver switches to two-wire mode at the
beginning of every resistance test. This causes a two-wire
to four-wire transition even when two successive four-wire
tests are performed.

This does not invalidate the test, but causes unnecessary
delay and unnecessary use of internal relays.

The problem also occurs with the 4000, 4000A, 4700, 4705,
4707, 4708, 4800, 4800A, and 4805 FSCs.

V6.11i or later is required to correct this problem.

----> M9500 Reset Statement Allows Other Fields to be Specified

Report #14891

In V6.11A the MET/CAL Editor fails to check for superfluous
fields in an M9500 statement which specifies "*" (RESET)
in the NOMINAL field.

For example, V6.11A allows:

M9500 * CH2 1T2

However, the "*" in the NOMINAL fields causes the other
parameters to take on default values. The above statement
actually sets the output channel to 1 and the trigger channel
to none.
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In V7.00 the M9500 statement has been changed so that:

(1) A blank M9500 statement causes the "*" to be
auto-inserted, resulting in "M9500 *".

(2) In any M9500 statement where the NOMINAL field is
"*" all other fields must be blank.

----> Blank M4XXX Statements Changed to Auto-Insert "*" in NOMINAL

Report #14892

In V6.11A a blank M4XXX statement (M4000, M4000A, M4200,
M4200A, M4700, M4705, M4707, M4708, M4800, M4800A, M4805,
and M4808) is ignored. A blank statement is not an error,
but it has no effect on procedure execution.

In V7.00 the procedure compiler auto-inserts a "*" (RESET)
in the NOMINAL field when a blank statement is entered.

----> Constructions [I] and [I$] not Document in "IEEE" Section of
Reference Manual

Report #14896

In V6.11A the [I] and [I$] constructions are missing from
the IEEE FSC Reference Manual section. V7.00 corrects this
error in the manual. (Note that the Editor's on-line manual
is correct in V6.11A and remains correct.)

----> 5520A 1-Year AC Voltage (Sinewave) Specs Not Updated

Report #14898

In V6.11A MET/CAL's 1-year (99%) accuracy file for the 5520A
was not updated when a number of the AC Voltage (Sinewave)
specs were loosened (about two years ago).

The accuracy file has been updated for V7.00.

It appears that the only changes to the ACV Sine 1-year
specs are:

(1) 33 mV to 329.999 mV range, 45 Hz to 10 kHz, change ppm
of output from 130 to 145.

(2) 33 mV to 329.999 mV range, 10 kHz to 20 kHz, change ppm
of output from 150 to 160.

----> 5520A 90-Day AC Voltage (Sinewave) Specs Not Updated

Report #14900

In V6.11A MET/CAL's "5520.acc" accuracy file contains
non-updated specs for 5 ACV sinewave ranges.

V7.00 updates the 90-day 5520 accuracy file as follows:

(1) 33 mV to 329.999 mV 45 Hz to 10 kHz change ppm of output
from 110 to 140.

(2) 33 mV to 329.999 mV 10 kHz to 20 kHz change ppm of output
from 120 to 150.

(3) 0.33 V to 3.29999 V 45 Hz to 10 kHz change ppm of output
from 100 to 140, and change floor from 25 uV to 60 uV.
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(4) 0.33 V to 3.29999 V 10 kHz to 20 kHz change floor from
50 uV to 60 uV.

(5) 3.3 V to 32.9999 V 45 Hz to 10 kHz change floor from
200 uV to 600 uV.

----> M4XXX Auxiliary FSCs Not Listed in Editor Help File

Report #14920

In V6.11A the Editor's general help file (accessed via F1 in
the Editor when the current line is blank) fails to list the
auxiliary FSCs M4000, M4000A, M4200, M4200A, M4700, M4705,
M4707, M4708, M4800, M4800A, M4805, and M4808.

These FSCs were added to support range locking in the
V6.11/V6.11A release.

In V7.00 the help file ("metcal.hlp") has been updated.

----> Add Control Over Saving of Repeated Test Results

Report #14924

All versions of MET/CAL from V1.00 to V6.11A implement a
specific algorithm to deal with repeated tests in the results.
If a particular test is repeated two or more times, only
the first and last executions of the test are saved in
the results. This algorithm is derived from an As Found /
As Left approach to verification.

V7.00 implements a more flexible scheme which allows the
workstation and/or site to configure the method for handling
repeated tests:

Option 1
Save the first and last executions of any test
executed 2 or more times. This is the same as the
current approach.

Option 2
Save only the last execution of a test. This option
may be used, for example, when MET/CAL is used in
a factory verification application, and only the
final execution of each test is to be saved.

Option 3
Save all test executions, regardless of how many
times a test is repeated. As with Option 1, only
the PASS/FAIL status of the last execution affects
the overall PASS/FAIL status of the procedure.

Note that the new options applies only to the "Results"
table, not to the "Cal Results" table. "Cal Results"
continues to operate exactly as it has in V6.11A and prior.

In MET/CAL V7.00 the RSM VSET parameter (Result Save Mode) may
be used to control the mode of saving repeated test results.
See "vset.hlp" for details.

----> 1271 & 1281 On-Line Help Fails to Show dBm as Legal Units

Reports #14931, #14932

In V6.11A and prior, the 1271 and 1281 FSCs support dBm ("D")
as legal NOMINAL field units, however the on-line help for
these FSCs does not document this.
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V7.00 includes corrected help files for these FSCs.

----> Test Tolerance Report in Volts when 437 FSC NOMINAL Specifies
dBm

Report #14933

In V6.11A and prior the T.U.R. report module linearizes 437
dBm test tolerance and system accuracy values by conversion to
Vrms, rather than watts. The T.U.R. is unaffected by this,
but the reported test tolerance and system accuracy should
be converted to W, not Vrms. V7.00 corrects the conversion.

----> Datron 4XXX Calibrator FSCs Now Support Range Locking Resistance

Report #14939

In V7.00 the M4XXX FSCs allow ohms ("Z") to be specified in
the NOMINAL field.

----> 1271, 1281, and 4950 Should Not Be Set To 1000V DC Range by
Reset Operation

Report #14965

In V6.11A and prior the 1271/1281/4950 "soft" reset function
sets the meter to the 1000V DC range.

The reset operation is performed during procedure execution
whenever the Post Test dialog is displayed, or following
an evaluation when ASK+ Q is in effect. By unconditionally
setting the meter to DCV, the meter setup and reading used
for the test are lost.

A typical scenario is as follows:

1. ASK- F is in effect (display Post Test upon FAIL).

2. 1271, 1281, or 4950 evaluation fails.

3. Reset operation performed by MET/CAL sets meter
to DCV.

4. Post Test dialog is displayed indicating failed
test.

5. Meter no longer displays reading that contributed
to the failed test.

In V7.00 the driver has been modified. The reset operation
now sends only "*CLS".

----> Allow Readonly Pre-Prompt Parameters to be Written to Variable
File

Report #14969

In V6.11A and prior the Run Time application does not write
readonly parameter values to the variable file
("variable.dat").

This has been changed in V7.00.

In V7.00 the Run Time has been changed so that, by default,
it writes readonly pre-prompt parameters to the variable file.

This feature requires V6.11l or later.
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Users who wish to retain the behavior of V6.11A and prior
may add "readonly_var = no" to the [Startup] section
of the initialization file. This will inhibit the Run Time
from writing readonly parameters to the variable file.

Here's an example of what you can do with the new feature:

(1) Add the line:

Model :RD: Model$ 4203

to the pre-prompt file (default name "promptdb.txt").

(2) In the procedure include a statement like:

MATH MEM2 = GETV("Model")

You now have the value of the database field 4203 in the
string register MEM2.

Suppose, for example, the UUT is a Fluke 5520A.
MEM2 would then contain the string "5520A".

The procedure writer may now use the JMPL FSC and the
MATH FSC's string comparison function to implement
conditional branching based on the model string.

----> 33120 Accuracy File should be 365 Days not 90 Days

Report #14974

In V6.11A the 33120A accuracy file has "interval = 90 days".
The 33120A specs are 1 year.

The accuracy file has been corrected in V7.00.

----> Run Time Crashes on Second Calibration When All Lines in
Pre-Run Prompt File Commented Out

Report #14976

In V6.11A the Run Time may crash in some cases when the
pre-run prompt file, default name "propmtdb.txt", has
been disabled by commenting out all the lines in the file.
In order for the problem to appear, the post-run pass and/or
fail prompt files must be enabled.

The crash occurs on the second calibration, immediately
after the prompt for the UUT asset number.

To avoid the problem, it is sufficient to specify
"prompt = none" in the MET/CAL initialization file.
This accomplishes the purpose of turning off all pre-run
prompts, but does not cause the crash described above.

V7.00 corrects this problem. (This bug fix actually requires
V6.11l or later.)

----> 4953 AC/DC Shunt not in List of Standards Used

Report #14977

In V6.11A a 4950 FSC statement utilizing the 10A range
requires the 4953 AC/DC Shunt, however the 4953 is not
included in the list of standards used.

V7.00 corrects this problem.
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----> New MATH FSC Function to Convert Seconds to HH:MM:SS

Report #14990

A request has been received for a MATH function which takes
as input a number of seconds and reformats as a string with
the form: HH:MM:SS.

This function may be useful in procedures which wish to
display elapsed or remaining time when time consuming
operations are underway.

The new function is MTIME. Refer to the on-line reference
for the MATH FSC for details.

----> 4808_99.1yr Accuracy File Error

Report #14992

In V6.11A the accuracy file is as follows:

Mode: Ohms 2W
# Nominal MOD1 Tolerance Floor
Resolution

0.0000000 0.0000000 NA NA NA NA 100e-9
2.000000 19.999999 NA NA 27e-4 200e-3 1e-6
20.00000 199.99999 NA NA 12e-4 200e-3 10e-6

It should be:

Mode: Ohms 2W
# Nominal MOD1 Tolerance Floor
Resolution

0.0000000 0.0000000 NA NA NA NA 100e-9
2.000000 19.999999 NA NA 27e-4 20e-3 1e-6
20.00000 199.99999 NA NA 12e-4 20e-3 10e-6

Per the manual, below 1 kohms is 20 mohms, not 200 mohms.
1 kohm and greater is correctly stated as 200 mohms

----> 4950 10A Zero Connection Message Incorrect

Report #15005

In MET/CAL V6.11A automatic message generated when zeroing
the 4950 10A range is incorrect. The message should show
connections to the 4953 shunt.

V7.00 corrects this problem.

----> MEASURE_ONLY VSET Parameter Should Apply to NTHROW as well
as NMEAS

Report #15018

In V6.11 there's a problem as described in the following
report:

We have a customer who has upgraded from MC5 to
MC6.11.
I understand that the NTHROW command in VSET affects
how the 3458 driver works with the MOD3 settings.
However, in the following procedure I would expect
MET/CAL to prompt for instructions to perform the
test at the outset and then take all 5 readings.
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1.001 ASK+ K
1.002 VSET mfile = u
1.003 VSET mfile_format = verbose
1.004 VSET NMEAS = 5
1.005 VSET MEASURE_ONLY = YES
1.006 VSET NTHROW = 2
1.007 3458 1.000000V 1P% 2W
2.001 END

What actually happens is MET/CAL prompts to perform
tests 3 times. In effect, the procedure resets between
the first 2 tests. I would not expect it to perform
this way with MEASURE_ONLY = YES.

Of course, this can be overcome by switching the N
flag off, but is this the answer?

In V7.00 the code has been changed. MEASURE_ONLY now affects
the NTHROW part of the measurement uncertainty loop as well
as the NMEAS part.

There is no way to cause MET/CAL to behave precisely as it
did in V6.11 & V6.11A in this regard. However, the risk is
low because it's hard to imagine a procedure which depends
on the fact that the reference meter is re-set up each time
through the NTHROW loop, but still does not want the meter
to be re-set up in the NMEAS loop.

This change affects the following FSCs:

1271, 1281, 2000, 2001, 2002, 2620T, 34401, 34420,
3458, 437, 4418, 4419, 45, 4950, 525, 5335, 5500,
5520, 5800, 5820, 5790, 6666, 6680, 6685, 8505,
8506, 8560, 8566, 8568, 8842, 8901, 8902, 8903,
8920, HP60, and HP63.

----> 1281 ACV Lower Limit Incorrect When Range Locked, 1 V Range
and Above

Report #15026

The 1281 is only specified down to 1% of full-scale.
Therefore the minimum reading is as follows:

2mV 100mV range
0.02V 1V range
0.2V 10V range
2V 100V range
20V 1000V

In V6.11A the lower limit is 2 mV independent of whether
the 1 V, 10 V, 100 V, or 1000 V range is locked.

V7.00 corrects this problem.

----> 1271 ACV Lower Limit Incorrect When Range Locked, 1 V Range
and Above

Report #15027

The 1271 is only specified down to 1% of full-scale.
Therefore the minimum reading is as follows:

2mV 100mV range
0.02V 1V range
0.2V 10V range
2V 100V range
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20V 1000V

In V6.11A the lower limit is 2 mV independent of whether the
1 V, 10 V, 100 V, or 1000 V range is locked.

V7.00 corrects this problem.

----> 1281 ACI Lower Limit Incorrect When Range Locked, 1 mA Range
and Above

Report #15028

The 1281 is only specified down to 1% of full-scale.
Therefore the minimum reading is as follows:

2uA 100uA range
0.02mA 1mA range
0.2mA 10mA range
2mA 100mA range
0.02A 1A

In V6.11A the lower limit is 2 uA independent of whether
the 100 uA, 1 mA, 10 mA, 100 mA, or 1 A range is locked.

V7.00 corrects this problem.

----> 1271 ACI Lower Limit Incorrect When Range Locked, 1 mA Range
and Above

Report #15029

The 1271 is only specified down to 1% of full-scale.
Therefore the minimum reading is as follows:

2uA 100uA range
0.02mA 1mA range
0.2mA 10mA range
2mA 100mA range
0.02A 1A

In V6.11A the lower limit is 2 uA independent of whether the
100 uA, 1 mA, 10 mA, 100 mA, or 1 A range is locked.

V7.00 corrects this problem.

----> 4950 ACI Lower Limit Incorrect When Range Locked, 1 mA Range
and Above

Report #15030

The 4950 is only specified down to 1% of full-scale.
Therefore the minimum reading is as follows:

2uA 100uA range
0.02mA 1mA range
0.2mA 10mA range
2mA 100mA range
0.02A 1A
0.2A 10A

In V6.11A the lower limit is 2 uA independent of whether the
100 uA, 1 mA, 10 mA, 100 mA, 1 A, or 10 A range is locked.

V7.00 corrects this problem.

----> 4950 ACV Lower Limit Incorrect When Range Locked, 10 mV Range
and Above
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Report #15031

The 4950 is only specified down to 1% of full-scale.
Therefore the minimum reading is as follows:

0.02mV 1mV range
0.2mV 10mV range
2mV 100mV range
0.02V 1V range
0.2V 10V range
2V 100V range
20V 1000V

In V6.11A the lower limit is 0.02 mV independent of whether
the 10 mV, 100 mV, 1 V, 10 V, 100 V, or 1000 V range is
locked.

V7.00 corrects this problem.

----> 8842 2nd and Subsequent Readings Incorrect for NMEAS > 1 and
MEASURE_ONLY = YES

Report #15045

In V6.11A if measurement uncertainty is enabled (NMEAS > 1)
and "measure_only = yes", the 2nd, 3rd, 4th, ..., nth 8842A
measurements are corrupted.

The problem was caused by the HV probe multiplier not being
properly set on the 2nd and subsequent invocations of the
8842A run time driver when "measure_only" was set to "yes".

V7.00 corrects this problem.

----> 45 2nd and Subsequent Readings Incorrect for NMEAS > 1 and
MEASURE_ONLY = YES

Report #15046

In V6.11A if measurement uncertainty is enabled (NMEAS > 1)
and "measure_only = yes", the 2nd, 3rd, 4th, ..., nth Fluke
45 measurements are corrupted.

The problem was caused by the HV probe multiplier not being
properly set on the 2nd and subsequent invocations of the
Fluke 45 run time driver when "measure_only" was set to "yes".

V7.00 corrects this problem.

----> Add Function to MATH FSC to Return Name of Executing Procedure

Report #15091

A MATH FSC function to return the name of the executing
procedure would allow using JMPL to replace existing JMPT and
JMPF statements. This would allow procedure writers to avoid
hardwiring step numbers in JMP-type procedure statements.
Using step numbers presents a procedure maintenance problem,
because it's easy to inadvertently introduce an error when
cutting and pasting procedure code. Using labeled jumps is
safer because it's unlikely that the procedure into which
a code fragment is being pasted already contains a labeled
jump destination which matches a JMPL in the fragment,
unless the fragment being pasted includes both the JMPL and
the corresponding LABEL statements.

Additionally, to save space on the JMPL line, and make it
more convenient to write procedures it might be nice to
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have a function which returns TRUE if a specified string is
a substring of the currently executing procedure.

In V7.00 three new functions have been added to the MATH FSC:

(1) PROC - returns the name of the currently executing
procedure. If the current procedure is a subprocedure,
the name of the subprocedure is returned.

(2) PSUB - returns 1 if a specified string is a substring
of the name of the currently executing procedure. If the
specified string is not a substring of the name of the
currently executing procedure, the return value is 0.
The comparison is case-sensitive.

(3) PSUBI - returns 1 if a specified string is a substring
of the name of the currently executing procedure. If the
specified string is not a substring of the name of the
currently executing procedure, the return value is 0.
The comparison is case-insensitive.

As with all MATH FSC functions, these 3 functions may be
used in a JMPL expression.

Most uses of JMPT and JMPF can probably be replaced by making
use of these functions.

----> Auxiliary FSC NOMINAL and MOD1 Values not Always Properly
Taken from MEM

Report #15166

In V6.11A a number of instrument FSCs incorrectly update
an auxiliary FSC Nominal or MOD1 value, taken from MEM,
when the main FSC executes.

Example:

2.001 MATH MEM = -4
2.002 M33120 Voff
2.003 MATH MEM = 2
2.004 33120 Vpp 1kH SI S L

When the above 33120 statement executes, the run time driver
takes the offset from MEM when the 33120 statement is
executed. The result is an offset of 2V instead of -4V.
This bug affects the following FSCs:

M2024
M33120
M395
M550
M5520
M5800
M5820
M8648
M9100
M9500
MSMY02

This bug has no effect as long as the value of MEM is not
changed between execution of the auxiliary and main FSCs.

V7.00 corrects this problem.

----> 9100 Statements with "TZ" in MOD2 Cannot Be Compiled

Report #15177
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In V6.11 and V6.11A 9100 statements with "TZ" in MOD2
cannot be compiled. The "TZ" is incorrectly identified as
a NOMINAL field. This problem did not exist in V6.10, but
was inadvertently introduced just before the release of V6.11.

Apparently "TZ" (Trapezoid) is little-used in the 9100 FSC.

V7.00 corrects this problem.

----> File Permission Problems under NT, 2K, and XP with NTFS

Report #15244

By default, under WinNT, Win2K, and WinXP, when using an
NTFS file system, writing to files and directories in the
Windows system directory and in the "Program Files" directory
requires Windows system administrator level access.

The problem most likely to arise from this situation is
that the MET/CAL initialization file ("metcal.ini") will be
unwritable on a MET/CAL client system.

When this problem is present, various error messages
will occur, depending on which application is executed.
For example, attempting to start the MET/CAL Run Time
application generates an error like:

E2242: Error writing parameter "method" to section
"Run Time" of file "C:\WINNT\METCAL.INI".

(Of course, the reported file name will vary, depending on
the name of the Windows directory.)

Note that the real error has nothing to do with the parameter
named "method". The problem is that "metcal.ini" is readonly,
and "method" just happens to be the first parameter which
the system attempts to write to "metcal.ini".

A more serious, but probably less likely, problem will
arise if the user browses to one of the Windows protected
directories during MET/CAL's client installation and chooses
to install MET/CAL there.

For example, choosing "C:\Program Files\METCAL" as the MET/CAL
directory on a client running NT, 2K, or XP with an NTFS
file system will leads to lots of problems, because there
are numerous application-specific files for which MET/CAL
requires write permission.

Users using MET/CAL V6.11A or earlier who experience the
"metcal.ini" problem described above may login on each client
as an Administrator, use the Windows Explorer, right click
on "metcal.ini", and modify the properties to allow write
access for all users.

The MET/CAL Install program for V7.00 has been modified so
that file permissions are adjusted as needed.

----> Change "metcal.ini" "525A_488_iterm" Default from "CR" to "EOI"

Report #15249

The MET/CAL initialization file ("metcal.ini") parameter
"525A_488_iterm" was added to support controlling a 525A
with an IEEE-488 to RS-232 converter. MET/CAL 6.11A
shipped with the default for this parameter set to "CR".
"CR" was required for use with the translators. However,
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production 525As that ship with an IEEE-488 will work only
with the parameter set to "EOI". MET/CAL 7.00 ships with the
"525A_488_iterm" default set to "EOI".

----> 5700 2-wire Statement Does not Generate Automatic Connection
Message

Report #15252

In V6.11A the following statement does not generate an
automatic connection message when ASK+ A or ASK+ V is
in effect:

5700 2 1.00V 0.01U 2W

V7.00 corrects this problem.

----> PORT FSC [REOPEN] Construction Works Only if Current Port
Established

Report #15269

The design of [REOPEN] from its inception up to and including
V6.11A has been that it affects the current port.

The initial condition at the start of execution of each PORT
statement is that the current port is not set.

Operations which establish the current port are:

(1) Read.

(2) Write.

(3) Execution of a [CLR] construction.

(4) Execution of a [P<params>] port configuration
construction.

(5) Execution of an [@<address>] construction.

Thus, if the current port has not been established at the
time of execution of a [REOPEN] construction, the construction
has no effect.

However, [REOPEN] will be more flexible and more useful if
it's changed so that it establishes the current port in the
same way that [CLR] does.

The algorithm for establishing the current port when it's
not known is:

(1) The UUT port, if known, becomes the current port.

(2) If the UUT port is not known, the UUT port and
the current port are both set to the default port
(as specified in the MET/CAL initialization file).
The default port can be configured using the
MET/CAL Config Editor (F12 in Editor or Run Time).

For V6.11A customers and earlier, an interim solution for
this lack of flexibility is to specify a [CLR] construction
prior to the [REOPEN] construction in any situation where
the procedure writer wishes to use [REOPEN] and the current
port has not been established.

Examples which work in V6.11A:
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PORT [CLR][REOPEN]
PORT [@5500][REOPEN]
PORT [@COM1][REOPEN]

Example which does not work in V6.11A:

PORT [REOPEN]

V7.00 corrects this problem.

----> 2001 FSC 4-Wire Ohms Upper Limit Incorrect

Report #15272

In V6.11A the Keithley 2001 4-wire ohms upper limit is 210
kOhm, not 2.1 MOhm. The 2002 4-wire ohms upper limit should
be 2.1 MOhm.

This mistake has been corrected in V7.00.

----> Too Many "Test Setup" Prompts Generated When NTHROW > 0

Report #15456

In V6.11A when a "meter" type instrument FSC function is
executed with ASK+ N, "Test Setup" prompts are generated
as follows:

"Set UUT to source <nominal>."

"Then set UUT to OPERATE."

Driver performs measurement(s).

"Set UUT to STANDBY."

These two sets of prompts should be generated at most
once for each test. However, the first set of prompts is
generated for each reading thrown away. That is to say,
if VSET NTHROW = 3, the operator will be directed to set
the UUT to source <nominal>. Then set UUT to OPERATE,
before each of the thrown away readings.

V7.00 corrects this problem.

----> 9100 Opt -135 Measurement Not Handled Correctly in Demo Mode

Report #15484

When a 9100 statement that uses opt -135 (Insulation
or Continuity measurement) is executed in demo mode, the
measurement entered is not properly converted to nominal
units.

Example:

When the following statement is executed in demo
mode, the operator is prompted to enter the 9100
reading in milliamps. However the entered value is
incorrectly converted amps and the test fails:

9100 1.00mA 1.00U 1kZ SE CO 4W

V7.00 corrects this problem.

----> 890X FSC Does Not Generate "Set UUT to STANDBY" Message with
ASK+ N & NMEAS > 0
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Report #15486

In V6.11A the 8901, 8902, and 8903 FSCs do not properly
generate the "Set UUT to STANDBY" message when ASK+ N is
set and measurement uncertainty is enabled (nmeas > 0).
Specifically the message is not generated when ASK+ N is in
effect and more than one reading is taken as follows:

nmeas = 1 and nthrow >= 1 or
nmeas > 1 and nthrow >= 0

The prompt is only correctly generated when nmeas = 0 or
nmeas = 1 with nthrow = 0.

V7.00 corrects this problem.

----> M680 and M681 Trigger Sensitivity Incorrect

Report #15507

In V6.11A the M680 and M681 help files and compile time
function restricts the PM 6680 and PM 6681 trigger sensitivity
to 20 mV, 50 mV, and 100 mV (X1 attenuation). Legal values
for PM 6680 and PM 6681 trigger sensitivity for X1 attenuation
are actually 0.00 V to 5.10 V in increments of 0.02 V.

V7.00 corrects this problem.

----> 6060 FSC Causes Incorrect Mod-Freq When Used with a 608X

Report #15547

In V6.11A the driver for the 6060 FSC uses the "MR"
command to select the modulation frequency. For a 606X,
MR0 selects 400 Hz and MR1 selects 1 kHz modulation frequency.
For a 608X, MR is not the native command. MR is supported
for 606X emulation. The problem is that the 608X firmware
has the 606X MR emulation inverted. When MR0 is sent to a
608X, 1 kHz modulation frequency is selected. Likewise the
when MR1 is sent to a 608X, 400 Hz modulation frequency
is selected.

In V7.00 the driver now uses MF<mod-freq>HZ command, which
is emulated correctly by the 608X.

----> 34420 Voltage Difference or Voltage Ratio Statement Causes
Header Error

Report #15714

In V6.11A a 34420 statement with MOD2 = VD (Voltage
Difference)
or nominal units of V/V (Voltage Ratio) causes error -113
"Undefined header".

This problem is corrected in V7.00.

----> Attempt to Use 34420 FSC with 34420A Connected to a Serial
Port Causes Timeout

Report #15739

In V6.11A if a 34420A is configured for serial control,
a timeout occurs after the first measurement is taken.

V7.00 corrects this problem.

----> Add "ask_c_default = no" to Initialization File for New
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Installations

Report #18344

Corrections are asset and elapsed time specific. However,
MET/CAL does not use asset and/or elapsed time information
to determine if use of a correction is valid or not valid.

In V6.11A if the parameter "ask_c_default" does not exist in
the MET/CAL initialization file, the default is "ask_c_default
= yes" (i.e., use corrections). For backward compatibility it
is not possible to simply change the default, as this might
affect upgrade customers. However, adding "ask_c_default
= no" to the initialization file for new installations of
MET/CAL is ok.

V7.00 implements the change described above to the default
MET/CAL initialization file.

----> 6680 with MOD3 = FC Causes Misleading Error Message

Report #18391

In V6.11A if an attempt is made to compile the procedure
statement:

6680 100.000MH 0.0001U 70.0mV +A FC 2W

with no PM 6680 configured, the following
message is generated:

E1528 : FSC 6680: If "FC" is specified in MOD3, PM
6680/6681 must be configured with option
PM 9621, PM 9624, or PM 9625.

However, configuring a PM 6681 with any one of the
three options will not allow the statement to compile.
Only configuring a PM 6680 with one of the options will
allow the statement to compile.

In V7.00 separate error messages for PM 6680 and PM 6681
are used.

----> 4700, 4705, 4707, 4800, 4800A, & 4805 Max Freq on 1000V Range
Incorrect

Report #18441

In V6.11A the procedure compiler does not restrict 4700, 4705,
4707, 4800, 4800A, & 4805 statements which use the 1000 V AC
range to the maximum frequency supported by the instrument.
For example the following statement does not cause a limit
error:

4800 210.000V 50kH S

However, an accuracy file lookup error is generated when
ASK+ U is in effect because the actual maximum frequency
for the 4800 at 210 V is 33 kHz.

V7.00 corrects this problem.

----> 5520 FSC with MOD3 = HC Generates Incorrect Automatic Connection
Message

Report #18731
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In V6.11A one connection message is missing.

The statement:

5520 12A 1% HC

does not cause the correct High Current Output connection
message to be generated.

V7.00 corrects the problem.

----> Configure Initially Highlighted Line for Post Test "List"

Report #19119

It has been pointed out that in V6.11A the operation of
Post Test "List" may be confusing for certain procedures
in the sense that re-starting execution at the initially
highlighted line may not be a well-defined operation.

This is true, and has always been the case with the MET/CAL
procedure language, but certain measurement uncertainty-
enabled
procedures, such as the example below:

1.001 ASK+ K A
1.002 ASK- N P W
1.003 VSET nsd = 2 nmeas = 1
1.004 5500 10.000mVpp 125.30kH SI S 2W
1.005 MEMI enter value in mV
1.006 MEMCX 15 10.000mVpp 1U 125.30kH

are particularly confusing.

In such cases it would be preferable to re-start the test
at the first line of the test, or at the TARGET statement,
if there is one.

Although the V6.11A implementation allows the procedure
writer to disable the "List" option altogether to prevent
the problem from arising, it would be better to support
a configurable option to allow either (a) re-start at the
last-executed statement or (b) re-start at the first line
of the test (or TARGET, if any).

A new initialization file parameter, "pt_list_current"
has been added for V7.00.

If "pt_list_current = yes", the initially highlighted line
is the last-executed step (i.e., the current line).

If "pt_list_current = no", the initially highlighted line
is first line of the test or, if there's a TARGET statement,
the TARGET line is highlighted.

The parameter is optional, and the default if "yes", which
is compatible with V6 and prior.

----> Correction to 4805 1-Year 99% Accuracy File

Report #19353

For the 1000 V range there's a gap in the V6.11A accuracy file
between 330 Hz and 3 kHz. In V7.00 the accuracy file for this
section has been changed to:

Mode: 1000V
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90.000 1100.000 10 330 xxxx
90.000 1100.000 330 10e3 xxxx
90.000 1100.000 10e3 33e3 xxxx

----> 8901 FSC Does Not Support 8901B

Report #19469

In V6.11A and earlier the 8901/8902/8903 driver expects the
following return format from an 8901:

SDDDDDDDDESDD<cr><lf> 15 bytes

In actuality this is only correct for the 8901A. The 8901B
and 8902A return format is:

SDDDDDDDDDDESDD<cr><lf> 17 bytes

In V7.00 the MET/CAL 8901/8902/8903 has been updated to
accept both the 8901A and 8901B formats.

------------------------------------------------------------------------------
--

Section 3 Documentation

Printed manuals have been updated for MET/CAL V7.00.

The V7.00 distribution contains the following documentation files:

GettingStartedV7.pdf

This is the MET/CAL and 5500/CAL Getting Started
Guide, Version 7.

Available in printed form as well as on-line.

InstallV7.pdf

This is the V7.00 Install Manual.

Available in printed form as well as on-line.

ReferenceManualV7.pdf

This is the MET/CAL V7.00 Reference Manual.

Available on-line only.

UsersManualV7.pdf

This is the MET/CAL Users Manual (Version 7).

Available in printed form as well as on-line.

PIItoMCTranslator.pdf

This is the User's Guide for the Portocal II to
MET/CAL results translator.

Available on-line only.

MetTemp611.pdf

MET/TEMP Users Manual (V6.11). This is the full
MET/TEMP manual, last updated for the V6.11 release.

Available on-line only.
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MetTempTour.pdf

MET/TEMP software tutorial. It was last updated at
the time of the MET/TEMP V6.01 release. (V6.01 was
the first version of MET/TEMP.)

Available on-line only.

ResultsTable7.pdf

This document lists the MET/CAL V7.00 Result
quantities, and shows the new database Results Table
column names.

Available on-line only.

QuickReferenceV7.pdf

This is the one-page hot keys sheet which shows the
hot keys used by MET/TRACK and the MET/CAL Editor.

Available in printed form as well as on-line.

RHT.pdf

This document explains how to use the Fluke 5000A
RH/T Precision Humidity and Temperature Data Logger
with MET/CAL V6.11 and later (including MET/CAL
V7.00).

Available on-line only.

The following "readme" files are provided. These are
available on-line only. "readme700.txt" (this file)
is the primary "readme" file for V7.00. "readme6.pdf",
"readme601.pdf", "readme610.pdf", "readme611.txt", and
"readme611A.txt" are supplied for upgrade customers who wish
to the understand the full sequence of software updates.

readme6.pdf

This is the readme file for the V6.00 release.

readme601.pdf

This is the readme file for the V6.01 release.

readme610.pdf

This is the readme file for the V6.10 release.

readme611.txt

This is the readme file for the V6.11 release.

readme611A.txt

This is the readme file for the V6.11A release.

readme700.txt
This is the readme file for the V7.00A release.
[ This is the file you are currently reading! ]

readme.txt

This is an abbreviated readme file which is displayed
when the MET/CAL client install program is run.
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------------------------------------------------------------------------------
--

Section 4 Manuals Errata

Users Manual

----> In Chapter 4, on page 4-6, the text:

If there are any picture (.bmp) files required,
the Run Time verifies that the specified files exist.

should be:

If there are any picture files required, the Run
Time verifies that the specified files exist.

The issue here is that MET/CAL V7.00 supports picture files
formats other than just .BMP.

----> On page 4-11, in the "Selection by Procedure Name" section,
the paragraph:

You can add, delete, or modify procedures using the
Editor. Open the Tools menu and select Administrator.
The Run Time application does not provide a way to
add, delete or modify procedures. It only allows
the operator to select a procedure to be executed.

should be replaced with:

You can add, delete, or modify procedures using
the Editor. The Run Time application does not
provide a way to add, delete or modify procedures.
It only allows the operator to select a procedure
to be executed.

The issue here is that in the MET/CAL V7.00 Editor
"Copy Procedures..." and "Delete Procedures..." are in the
top-level "File" menu. It's no longer necessary to invoke
the Administrator via the "Tools" menu.

----> On page 4-12 the "Options" section name should be "Configure"
and the text:

Choosing "Options" causes a drop-down submenu
to display.

should be replaced with:

Choosing "Configure" causes a drop-down submenu
to be displayed.

----> On page 4-14 the section title:

Autosave Pass / Autosave Fail Macros

should be:

AutoMacro (Pass) / AutoMacro (Fail) Macros

The following sentence:

The Autosave pass and Autosave Fail macros...

should be:
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The AutoMacro (Pass) and AutoMacro (Fail) macros...

----> On page 4-27 in the section on "Setting up Memory Registers"
step (3) should be deleted and step (4) should be renumbed
as step (3).

----> On page 4-30 the sentence:

The UUT data must be obtained prior to execution of
the MEMC statement.

should be replaced with:

The UUT data must be obtained prior to execution of
the MEMC or MEMCX statement.

----> On page 4-31, in the section "Example, User-configured
Measurement Instrument", the following text:

5. Evaluation - Compare the UUT Indicated (MEMCX
Nominal Value) to the System Actual (MEM) against
the UUT specification in the Tolerance field.

should be:

5. Evaluation - Using the UUT specification in the
TOLERANCE field, compare the UUT Indicated (MEMC
NOMINAL value) to the System Actual (MEM).

----> In the section on MET/CAL initialization file parameters the
line on page 7-14:

pidir = picture_directory

should be:

picdir = picture_directory

----> In the section on MET/CAL initialization file parameters the
line on page 7-17:

pocdir = picture_directory

should be:

procdir = procedure_directory

------------------------------------------------------------------------------
--

Section 5 Reports

MET/CAL V7.00 includes the following reports:

( 1) basic_inventory.rpt
( 2) basic_report_template.rpt
( 3) cal_due_by_asset_for_xxx_days.rpt
( 4) cal_due_by_asset_through_date.rpt
( 5) cal_due_by_dept_by_status_for_xxx_days.rpt
( 6) cal_due_by_location_by_status_thru_date.rpt
( 7) cal_due_by_tech_by_status_for_xxx_days.rpt
( 8) cal_due_by_tech_by_status_thru_date.rpt
( 9) cal_procedures_and_revs_for_eqpt.rpt
(10) cal_summary_for_asset_number.rpt
(11) cal_summary_for_work_order.rpt
(12) field_customization.rpt
(13) field_properties.rpt
(14) license.rpt
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(15) master_inventory_for_asset_number.rpt
(16) rt_certificate_of_cal_or_failed_cal.rpt
(17) rt_report_of_cal_ver_7.rpt
(18) rt_report_of_cal_ver_7_color_coded.rpt
(19) rt_report_of_cal_ver_7_failures.rpt
(20) rt_report_of_cal_with_exp_uncert.rpt
(21) screen_customizing.rpt
(22) trace.rpt

The list above shows the report file names.

To install reports use MET/TRACK. Login as "MT", and choose first
"Install Reports", then "Configure Reports" in the top-level
"Set-Up" menu.

Additional reports are included on the MET/CAL Bonus Disk.

A brief description of each report on the MET/CAL 7.00 CD (not the
Bonus Disk) is provided below:

basic_inventory.rpt

A basic report that shows just inventory data. This
report can be used as a template for other reports.

basic_report_template.rpt

A basic report that shows inventory data.
Specifically designed to be used as a template.
Has the joins set to left outer.

cal_due_by_asset_for_xxx_days.rpt

Prompts the operator for the number of days from today
and shows assets with calibration due and overdue.

cal_due_by_asset_through_date.rpt

Prompts the operator for the date and shows assets
with calibration due and overdue.

cal_due_by_dept_by_status_for_xxx_days.rpt

Prompts the operator for the number of days from today
and groups the calibration due data by department
and by status.

cal_due_by_location_by_status_thru_date.rpt

Prompts the operator for a date and groups the
calibration due data by status and location.

cal_due_by_tech_by_status_for_xxx_days.rpt

Prompts the operator for number of days from today
and groups the calibration due data by technician
and status.

cal_due_by_tech_by_status_thru_date.rpt

Prompts the operator for a date and groups the
calibration due data by status and technician.

cal_procedures_and_revs_for_eqpt.rpt

Lists all calibration procedures listed in field
C2320 and shows the revisions.
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cal_summary_for_asset_number.rpt

Prompts the operator for an asset number and gives
the summary data for the asset.

cal_summary_for_work_order.rpt

Prompts the operator for a work order number and
gives the summary data for the asset.

field_customization.rpt

Shows the current customization of the database
fields.

field_properties.rpt

Shows the current customization of the properties
for the database fields.

license.rpt

Lists all of the licenses assigned to the database
and shows the version and serial numbers.

master_inventory_for_asset_number.rpt

Provides all inventory information for a specified
asset number.

rt_certificate_of_cal_or_failed_cal.rpt

Generates a calibration certificate. Usually invoked
from the Run Time application after a calibration
has completed. Covers both PASS and FAIL
calibrations.

rt_report_of_cal_ver_7.rpt

This is the basic report used to show full results
generated by the MET/CAL Run Time application.
This report uses result data from the new V7.00
Results Table. It is not a legacy report, so the
"rslt_db.frm" file has no effect on the information
presented by this report.

rt_report_of_cal_ver_7_color_coded.rpt

Similar to "report_of_calibration_ver_7.rpt", but
shows failures with a red background and marginal
passes with a yellow background. (The color coding
is similar to MET/CAL's Test Results window.)

rt_report_of_cal_ver_7_failures.rpt

Similar to "report_of_calibration_ver_7.rpt", but
shows only tests which failed.

rt_report_of_cal_with_exp_uncert.rpt

Similar to "report_of_calibration_ver_7.rpt" but
shows expanded measurement uncertainty rather than
test uncertainty ratio.

screen_customizing.rpt

This report shows the current customization of
the screens.
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trace.rpt

This report is used with the forward trace and
reverse trace functions of the MET/TRACK.

------------------------------------------------------------------------------
--

Section 6 On Time Support Products

On Time Support, Inc. provides software products to enhance or
augment the functioning of your MET/CAL and MET/TRACK software.
The following On Time Support programs may be purchased directly
from Fluke. Contact your local Fluke representative for specific
details, options, and prices. Additional information is also provided
on Fluke's WEB site:

http://www.fluke.com

Metrology/Xplorer

Metrology/Xplorer is a web-based query tool used to retrieve
MET/CAL and MET/TRACK data with your browser, over the
internet or your company's intranet.

Barcode Magician

Barcode Magician (BCM) is a product from On Time Support
Inc. which allows you to automate repetitive database
entry tasks such as checking in/out equipment, or changing
equipment status simply and consistently for quantities of
assets using a simple barcode tool or keyboard.

BCM provides a simple, easy to use interface that allows
your calibration technicians and instrument custodians
a way to update your Fluke MET/BASE database quickly and
efficiently while at the same time drastically reducing
data entry errors and substantially increasing productivity.
By using a barcode scanner in conjunction with this software,
you can automate such tasks as:

(1) Checking in/out equipment from a tool crib or
instrument impound area.

(2) Updating in-process status descriptors.

(3) Changing location and association of assets.

(4) Accepting instrumentation for repair work.

(5) Virtually any database function other than
calibration data entry, repair record creation,
or addition of instruments.

On Time Support has developed additional programs which enhance
the benefits of MET/CAL Plus. The following applications
may be obtained directly from On Time Support. Please see
"http://www.ontimesupport.com" for full information, or contact On
Time Support at:

ON TIME SUPPORT Inc.
Voice - 281.296.6066;
Fax - 281.465.9478;
E-mail - inquiries@ontimesupport.com;
U.S. Mail - 25132 Oakhurst Drive, Suite 185

Spring, Texas 77386-1443
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Process/Track

Process/Track allows users to create, download, and upload
procedures and data from Fluke 702, 743B, and 744 documenting
calibrators, using the MET/CAL-Plus database. The software
is fully automated. Process/Track will combine metrology and
process calibrations into one system with complete forward
and reverse traceability.

(1) Data from every calibrator is stored in one database,
providing complete traceability.

(2) Calibration records are created automatically in your
existing Fluke MET/BASE system expediting calibration
record recording and eliminating data entry errors.

(3) Calibration data is immediately accessible in the Fluke
MET/BASE system after upload.

(4) Existing calibration reports and test result certificates
may be used with newly created calibration data.

Change/Log

On Time Support has created a plug-in for the MET/TRACK
database (version 6.x, 7.x) that keeps track of changes to
the Inventory, Calibration, Location, Maintenance, Customer,
and Standards tables. No front end program is required to
configure the Change/Log option. Change/Log tracks database
changes regardless of the application which makes the change.
You can update your database using MET/TRACK Manual Entry,
MET/CAL Run Time, Barcode Magician, ISQL, or any other
application and Change/Log will maintain a full record of
the change history. Change/Log is particularly useful for
customers who may be subject to FDA regulatory requirements.
An archive function is included.

Remote Pipeline

Remote Pipeline allows calibration lab supervisors/technicians
to operate multiple workstations in remote locations where
a continuous connection to a master server is difficult
or impossible - and operate using the same database at
every site. Remote Pipeline is a conduit that enables each
remote system to share or replicate data with a master,
consolidated Fluke MET/CAL database. Fluke MET/CAL customers
can simultaneously operate many MET/CAL, 5500/CAL, MET/TRACK,
Barcode Magician, and Process/Track workstations to calibrate
instrumentation, perform process calibrations, or inventory
instrument locations.

------------------------------------------------------------------------------
--

Section 7 Contacting Fluke

For assistance and questions regarding Fluke Metrology Software
please contact MET/SUPPORT at:

phone: 1 (800) 825-7411
email: MetSupport@fluke.com

European customers may contact the MET/SUPPORT group in
Europe via email at:

MetSupport@fluke.nl

To directly contact the MET/CAL software development team you may send
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email to:

Matt.Nicholas@fluke.com

------------------------------------------------------------------------------
--
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